
Open command (File menu - F3)

This command provides a standard interface to open an existing file for 
viewing.    The dialog box options are:

File Name Select or type the file to view
File Type Set to All files
Directories Select the directory to be listed
Drives Select the drive to be browsed

See Also: File Close



      View command (File menu - F4)

Selecting the File-View command will cause the currently selected document 
in the files window to be viewed.    If the format of the selected file is one of 
the supported formats, then a highly formatted view of the document will be 
displayed in the view window.

To set individual display options select Options and Display entry of the 
Context Menu.



Close command (File menu - F5)

The Close command will close the currently viewed file.    Other applications 
may not be able to load a file while it is being viewed by Quick View Plus.    If 
this happens, use the Close command to close the view and then try re-
opening the file.



      Print command (File menu - F6)

When you view a file in the Document Viewing Window, Quick View Plus 
allows you to print the file with formatting (bold, italic, etc.), even if you do 
not have the application that created the file on your system.    

To print the current file, from the File Menu, choose Print.    You can also 
choose the print button in the Tool Bar.

This command accesses the print dialog box.    The dialog box shows you the 
current document and the current printer.    You can print a selected area, or 
the entire document.    To print the defined area, Choose the Print button.

Choose the Options button to set print options.    You can also set these 
options by selecting Print Options from the Options menu. 

Choose the Printer button to select the printer.    You can also select the 
printer by selecting Print Setup... from the File menu. 



Print Setup command (File menu)

The Print Setup command accesses a dialog box which allows you to set the 
typeface and font size that the printed page will use.    It also allows you to 
select whether a header is printed on each page.    If you select a header, it 
will print on every page.    The header will be italic and will have a horizontal 
line beneath it.    The header consists of the document title on the left, and 
the page number on the right side of the page.



      Launch command (File menu - F7)

When you display a file, Quick View Plus allows you to launch the application 
in which the file was created with the file already loaded.    You can then edit 
the file in the application.    Quick View Plus can launch both DOS and 
Windows applications.

To launch an application, view the file you want to edit.    From the File Menu, 
choose Launch.    (You can also choose the Launch button in the Tool Bar or 
press (F7).)    

Quick View Plus associates each file type with an application.    This 
information is established during installation and can be modified using the 
launch options.    If the file being launched is not yet associated with an 
application, Quick View Plus will bring up the Launch Application Setup 
dialog.

Some applications do not run well under Windows; launching these programs
is not supported in Quick View Plus:

DataEase 4.2
dBase III
dBase IV
DisplayWrite 2 & 3
DisplayWrite 5
Enable
First Choice 3.02
Lotus 1-2-3 (DOS versions)
Lotus Manuscript
Lotus Symphony
Mass-11
Microsoft Excel 2.10
MultiMate 4
MultiMate Advantage II
Paradox
Paradox 3.0
R:Base 3.1
Samna IV
VP Planner 3D

Some applications do not support loading a file from the DOS command line.  
Quick View Plus will launch these programs, but is not able to load 
documents for the following applications:

DisplayWrite 4



First Choice 2.0
Mosaic Twin
MultiMate 3.6
PC File 5.0
Q&A
Smartware II
Volkswriter 3

The following applications will cause an inactive window to appear when the 
application is exited.    You should close this inactive window before returning 
to Quick View Plus.

Professional Write 1
MultiMate 3.6
PFS:Professional Plan



Tear Off command (File menu - F8)

Once you view a file, you can tear it off into its own window.    After you tear 
off a view, you can load a different file in the Document Viewing Window.    
This option can be useful to allow you to compare different files.    It also 
allows you to have several files open at once and toggle among them.    

To tear off a view, from the File Menu, choose Tear Off or press (F8).    You can
also tear off a view by grabbing and moving it.    You grab it by positioning 
the mouse in the Format ID tile in the upper left corner of the Document 
Viewing window.    When you move the mouse to this location, it changes 
shape from an arrow to a hand.    Before you can tear off the view, you must 
left-click with the mouse and hold the mouse button down.    To tear off the 
view, move the window to the left or right and then release the mouse 
button.

You can print, copy, and launch from a torn off view using the options on the 
window's system menu (Alt-spacebar).



Exit command (File menu)

This command will close your Quick View Plus session, including all torn off 
views.    This can also be accomplished by selecting Close from the system 
menu.



Rename command (File menu - F9)

The Rename command allows you to change the name of one or more files.    
To rename files, first select the files you wish to rename in the Files Window.   
Next, use the Rename option on the File Menu to access the Rename dialog 
box.

The Rename dialog box will prompt you for the new name of the file(s).    
Wildcards can be used to rename more than one file according to a defined 
pattern.    For example, to change the extension of all selected files to BAK, 
enter *.BAK in the Rename dialog box.



      Copy command (File menu - F10)

The Copy command allows you to copy one or more files to a new location.    
To copy files, first select the files you wish to copy in the Files Window.    Next,
access the Copy dialog box by using the Copy option on the File Menu, or the
Copy button on the Toolbar.

The Copy dialog box will prompt you for the location to copy the files.    Type 
in the destination or use the browse button to select the drive and directory 
from a list box.    An option allows confirmation before overwriting any 
existing files during the copy.    If this option is checked, you will be prompted
for confirmation when an existing file is about to be overwritten.

Note:    To select all of the files in the file list window, select the first file, 
scroll to the bottom of the list, and hold down the shift key while selecting 
the last file in the list.    The entire list will be selected.



      Move command (File menu - F11)

The Move command allows you to move one or more files to a new location.   
To move files, first select the files you wish to move in the Files Window.    
Next, access the Move dialog box by using the Move option on the File Menu,
or the Move button on the Toolbar.

The Move dialog box will prompt you for the location to move the files.    Type
in the destination or use the browse button to select the drive and directory 
from a list box.    An option allows confirmation before overwriting any 
existing files during the move.    If this option is checked, you will be 
prompted for confirmation when an existing file is about to be overwritten.

Note:    To select all of the files in the file list window, select the first file, 
scroll to the bottom of the list, and hold down the shift key while selecting 
the last file in the list.    The entire list will be selected.



      Delete command (File menu - F12)

The Delete command allows you to delete one or more files.    To delete files, 
first select the files you wish to delete in the Files Window.    Next, access the 
Delete dialog box by using the Delete option on the File Menu, or the Delete 
button on the Toolbar, or by pressing the Delete key while focus is in the Files
Window.

The Delete dialog box shows the number of files selected for deletion and a 
checkbox which allows confirmation before deleting files.    If this option is 
checked, you will be prompted for confirmation when an existing file is about
to be deleted.    The confirmation check box is not accessible if only one file is
being deleted.

Note:    To select all of the files in the file list window, select the first file, 
scroll to the bottom of the list, and hold down the shift key while selecting 
the last file in the list.    The entire list will be selected.



History command (File menu - 1,2,3,4,5)

As you view different files, Quick View Plus always remembers the last five 
files you used.    These file names appear at the bottom of the File menu.

To view any of these files, choose the file name or type the file number 
displayed next to the name.



      Copy command (Edit menu - Ctrl+C)

The copy command allows you to copy selected text or data to the clipboard.    The 
clipboard is a feature of Windows that allows you to transfer information between 
applications.    Once you have selected the text you want in the document viewing 
window, you can copy it to the clipboard with the Copy function in the Edit menu.    You 
can also bypass the menu and copy text directly by choosing the Copy button.    

For a complete discussion see Transferring Data to your Windows Application.



      Paste to Application command (Edit menu)

This command is only available when Quick View Plus is run from one of the word 
processor macros.

After selecting the data you wish to transfer, use this command to copy your data to the 
clipboard, paste the data directly to your word processor and return to your word 
processor in a single step.    The data will be pasted at the current insertion point in your
word processor.

See Also:    Transferring Data to your Windows Application



Select All command (Edit menu - Ctrl+A)

Use this command to select all of the data in the viewed file.    You can then copy the 
entire selection to the clipboard.



      Search command (Edit menu - Ctrl+S)

The Search function allows you to enter a text string, and then direct Quick View Plus to
search for that string within the currently displayed document.

When the search dialog appears, enter the search string and indicate whether case 
sensitivity should be on or off.    You can also set whether the search will be toward the 
top of the document or the bottom.

When you choose the Search button, Quick View Plus searches for the text.    When it 
finds the search string, it highlights the text.

To repeat the previous search, select Search Previous or Search Next from the Edit 
menu or press (Ctrl)-(R).



      Search Previous command (Edit menu - Ctrl+P)

The Search Previous command will search backward from the current position for the 
defined search string.    Use the Search command to set up the initial search criteria.



      Search Next command (Edit menu - Ctrl+N)

The Search Next command will search forward from the current position for the defined 
search string.    Use the Search command to set up the initial search criteria.



General Options

The general options allow you to choose how the files in the Files Window should be 
sorted and how many mouse clicks are necessary to view a file..    The dialog box 
groups are described below:

Sort file by:

None 
Display files in the DOS file structure order.

Name
Sort files alphabetically according to the file name.

Extension
Sort files alphabetically according to the file extension.

Date & Time 
Sort files chronologically according to the date & time the file was last updated.

Size
Sort files according to the file size, smallest to largest.

View file on:

Single Click
Single clicking on a file in the list window will bring up a view of the file.

Double Click
Double clicking on a file in the list window will bring up a view of the file.



Launch Options

The launch options allow you to set up launch parameters for particular types of files.    
To do this, from the Options menu, select Launch Options.    This option allows you to 
define execution information for any supported application.

The Application Launch Information dialog shows the Application name and the 
Current Execution command.    The Current Execution command is the command that 
loads the application.    The execution command is display-only on this dialog box.

To select an application, click on the down arrow beside the Application Name field.    A 
list of application names drops down.    Scroll through the list and choose the one you 
want.    When you select an application, if Quick View Plus is already set up for it, the 
current command appears in the Current Execution Command field.    If the application 
is not set up, the field appears blank.    

If you want to modify the Current Execution Command, choose the Modify button.    
This will bring up the Launch Application Setup dialog.



Launch Application Setup Dialog

In order for Quick View Plus to launch an application, it must know the Current 
Execution Command.    This command consists of the path, name and extension of the 
executable command, and any parameters that the application requires.    You can enter
the Current Execution Command by choosing the Modify button on the Launch 
Application Information dialog.    You also enter it if you try to launch an application for 
which Quick View Plus has no launch information.

The Launch Application Setup dialog box is similar to the Application Information dialog 
box.    The Command field allows you to enter the command that loads the application.    
There is plenty of room to also enter any command line delimiters the application might 
use.    For example, Microsoft Word 5.5 uses the delimiter /G to signify that it should 
load in Graphics mode.    If you wanted to use this delimiter, and if the program was in 
the \WORD directory on the C: drive, then the execution command would be: C:\WORD\
WORD.EXE /G.

Browsing for Launch Applications - Quick View Plus allows you to browse for the 
path and execution file if you wish.    To browse for the file, choose the Browse button.    
When you choose this button, the Launch Browse dialog appears, which allows you to 
browse through the various drives and directories to find the file you want.    The File 
Name field contains the file extensions that execution files may use.    The List Files Of 
Type field allows you to select either executable files or all files.    If you select all files, 
the parameter in the File name field changes to *.*.      The dialog box also allows you 
select the drive and directory.

Searching for Launch Applications - Another way to find the application's executable 
file is to set the type of file you want, and then use the search option.    This option will 
search all of the directories on the local drives to find the execution file specified.    
When you choose the Search button, the Launch Search dialog appears.    This dialog 
box shows you its progress as it searches through all of the directories on the disk 
looking for the proper executable file.    When it thinks it has found the proper file, it 
stops the search and displays the message: Press OK to use this path; press 
CONTINUE to find next application directory, or press CANCEL to exit without using 
Search information.    Some applications have the same executable file name.    If the 
search finds an executable file, but in the wrong path, choose CONTINUE to find the 
next application.

If you are in the Launch Options menu, choosing OK will only save your settings.    
However, if you access the Launch Setup Menu by choosing Launch from the File Menu
or by choosing the Launch button, choosing OK will execute the Launch.



Display Options

The Display Options allow you to set the display font and select the default viewing 
mode of files which could not be identified.    To customize display options, choose 
Options and Display... from the Context Menu.

Default font
The default display font is used when viewing a document in draft mode, and when 
viewing a spreadsheet or database file.    This font is also used when displaying text in a
file for which Quick View Plus has no font information.    To select a different default 
typeface for the display, in the Face field, choose the down arrow.    Quick View Plus 
displays the available typefaces.    Please note that these typefaces are screen fonts, 
not print fonts.    Choose the one you want to use.    To select a different display font 
size, in the Size field type the desired size.    Or choose the down arrow.    Quick View 
Plus displays the available sizes for the font you chose.    Choose the size you want.

View unknown files as...
When you select a file to display in the Document Viewing Window, if Quick View Plus 
cannot identify the application that created the file, it considers that file to be in an 
unknown format.    The program can still display the file, but it will use the default format 
you select here.    In the View unknown files as box, you can select as the default:

Text
Displays the files using one of the 5 character sets.    

Hexadecimal
Displays the files in hexadecimal format.

Do not view 
Quick View Plus will not view files with an unknown format.    When you select an 
unknown format, the Quick View Plus logo appears instead of the file contents.

More...
The more button in the display options dialog allows setting additional display 
options based on the type of file currently being viewed.    Additional display options 
are available when viewing spreadsheet, database, and archive files.



Spreadsheet

Show gridlines - If you select Gridlines, Quick View Plus will display lines that show the
outline of each cell in the spreadsheet in the Document Viewing Window.    When you 
deselect Gridlines, the program no longer displays the gridlines.



Database

Show gridlines - If you select Gridlines, Quick View Plus will display lines that vertically
separate each field in the database.    When you deselect Gridlines, the program no 
longer displays the gridlines.



Archive

Sort Order - The archive display options allow setting the sort order used to display the 
files contained within an archive file.    The possible sorting options are:

Don't sort files - The archive directory is listed in the order the files are stored 
internally within the archive file.

Sort files by name - The archive directory listing is ordered alphabetically by file 
name.

Sort files by size - The archive directory listing is ordered by file size from 
smallest to largest.

Sort files by date & time - The archive directory listing is ordered by file date 
and time from earliest to latest.



More Display Options

Spreadsheet

Show gridlines - If you select Gridlines, Quick View Plus will display lines that show the
outline of each cell in the spreadsheet in the Document Viewing Window.    When you 
deselect Gridlines, the program no longer displays the gridlines.

Database

Show gridlines - If you select Gridlines, Quick View Plus will display lines that vertically
separate each field in the database.    When you deselect Gridlines, the program no 
longer displays the gridlines.

Archive

Sort Order - The archive display options allow setting the sort order used to display the 
files contained within an archive file.    The possible sorting options are:

Don't sort files - The archive directory is listed in the order the files are stored 
internally within the archive file.

Sort files by name - The archive directory listing is ordered alphabetically by file 
name.

Sort files by size - The archive directory listing is ordered by file size from 
smallest to largest.

Sort files by date & time - The archive directory listing is ordered by file date 
and time from earliest to latest.



Print Options

Default font
The Print Options dialog allows you to set the typeface and font size that the printed 
page will use when printing text for which no original font information is known.    The 
default font is used when printing spreadsheets and databases also.

Header & Header font
The page layout options allow you to select whether a header is printed with the file.    If 
you send a header, it will print on every page.    You can also select the typeface and 
font size that the header will appear in.      The default header consists of the document 
title on the left, and the page number on the right side of the page.

Job Name
You can choose what text will appear in the header by entering it in the job name field.    
Use %F to include the file name in the header.

Page margins
The page margins of the printed file can be set from this dialog box.    The rectangle to 
the right of the page margin settings provide a sample of the page margins.    The page 
margins cannot be set to less than .25 inches.

More...
The more button in the print options dialog allows setting additional print options based 
on the type of file currently being viewed or printed.    Additional print options are 
available when viewing spreadsheet, database, bitmap, and drawing files.



More Print Options

Spreadsheet

Print gridlines - The Spreadsheet options also allow you to set how a spreadsheet 
looks when printed.    If you select Print gridlines, Quick View Plus will print lines that 
show the outline of each cell in the spreadsheet.
Print row & column names - If you select Print row & column names, Quick View Plus 
prints numbers for the rows and letters for the columns.

Database

Print Gridlines - The database options also allow you to set how a database looks 
when printed.    If you select Print gridlines, Quick View Plus will print lines that vertically 
separate each field in the database.
Print field names - If you select Print field names, Quick View Plus prints the field 
names for the columns.    

Bitmap

Aspect Ratio - The aspect ratio defines the ratio between the horizontal and vertical 
size of a pixel.    When you print bitmaps, you can optionally set the aspect ratio to one 
of two values.    If set to Original, the image is sized to the page margins, maintaining 
the aspect ratio.    If set to Stretch to Margins, the image is sized to the page margins, 
stretching the bitmap if necessary.

Print Border - This option allows a thin black border to bound the printed image.

Drawing

Aspect Ratio - The aspect ratio defines the ratio between the horizontal and vertical 
size of a pixel.    When you print drawings, you can optionally set the aspect ratio to one 
of two values.    If set to Original, the image is sized to the page margins, maintaining 
the aspect ratio.    If set to Stretch to Margins, the image is sized to the page margins, 
stretching the drawing if necessary.

Print Border - This option allows a thin black border to bound the printed image.



Spreadsheet

Print gridlines - The Spreadsheet options also allow you to set how a spreadsheet 
looks when printed.    If you select Print gridlines, Quick View Plus will print lines that 
show the outline of each cell in the spreadsheet.
Print row & column names - If you select Print row & column names, Quick View Plus 
prints numbers for the rows and letters for the columns.



Database

Print Gridlines - The database options also allow you to set how a database looks 
when printed.    If you select Print gridlines, Quick View Plus will print lines that vertically 
separate each field in the database.
Print field names - If you select Print field names, Quick View Plus prints the field 
names for the columns.    



Bitmap

Aspect Ratio - The aspect ratio defines the ratio between the horizontal and vertical 
size of a pixel.    When you print bitmaps, you can optionally set the aspect ratio to one 
of two values.    If set to Original, the image is sized to the page margins, maintaining 
the aspect ratio.    If set to Stretch to Margins, the image is sized to the page margins, 
stretching the bitmap if necessary.

Print Border - This option allows a thin black border to bound the printed image.



Drawing

Aspect Ratio - The aspect ratio defines the ratio between the horizontal and vertical 
size of a pixel.    When you print drawings, you can optionally set the aspect ratio to one 
of two values.    If set to Original, the image is sized to the page margins, maintaining 
the aspect ratio.    If set to Stretch to Margins, the image is sized to the page margins, 
stretching the drawing if necessary.

Print Border - This option allows a thin black border to bound the printed image.



Clipboard Options

The Clipboard options allow you to customize the data copied to the Windows clipboard.

Formats to be placed on clipboard - When you copy text to the clipboard, Quick View 
Plus places the text on the clipboard in each of the formats checked.    To obtain the 
best results, you can select from the following formats:

Text
ASCII format

Rich Text Format
Supports Word for Windows, WordPerfect for Windows, PageMaker, JustWrite, and 
many others. 

Ami 2.0 & 3.0
Ami 1.2
Professional Write +
WordStar for Windows
Legacy

Bitmap
A device-dependent, pixel-based graphic representation.

Device Independent Bitmap (DIB)
A device-independent, pixel-based graphic representation.

Metafile Picture
A Windows standard, drawing-based representation.    This format is not placed on 
the clipboard when part of a drawing is selected and copied.

Palette
The set of colors used in creating the drawing.    A palette will not be placed on the 
clipboard when True Color drawings are copied, unless a 256-color device is being 
used to view the image.

Only select the formats you need, as each format takes up space in the clipboard since 
your selection is duplicated for each chosen format.

Clipboard Default Font Face - This option allows you to select the typeface that Quick 
View Plus uses when you copy data to the clipboard.    Quick View Plus will use this font
in either of the situations described below:

There is no font information in the original file.



The Include Character Face on Clipboard option is off.

To select a different typeface, choose the down arrow.    The program displays the 
available typefaces.    Choose the one you want to use.

Clipboard Default Font Size - This option allows you to select the type size that Quick 
View Plus uses when you copy data to the clipboard.    Quick View Plus will use this size
in either of the situations described below:

There is no font size information in the original file.
The Include Character Size on Clipboard option is off.

To select a different type size, choose the down arrow.    The program displays the 
available type sizes.    Choose the one you want to use.



More Clipboard Options

Spreadsheet
The spreadsheet clipboard options allow you to customize options used when copying 
spreadsheet data to the clipboard.

Copy as table
inserts the data as a table, rather than as tab delimited text

Copy using optimized tabs
places a tab between each cell that has data in it (skipping empty cells)

Copy using tabs 
places a tab between each cell

Database

The database options allow you to customize options used when viewing, printing, and 
copying database data.

Copy as table
inserts the data as a table, rather than as tab delimited text

Copy using optimized tabs
places a tab between each cell that has data in it (skipping empty cells)

Copy using tabs 
places a tab between each cell



Default Font

Use the font dialog to choose the current default font type, style, and size for the current
option.
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Document Menu

The Document Menu is only available when viewing word processing or text 
documents.    This menu is also available as a right-click context menu.

Copy - Copies selected text, data or images to the Windows Clipboard.

Print - Prints the viewed file or selection.

Draft Mode - The file is displayed using the default font set in the display 
options.    The text wraps so that it does not run outside the viewing area.    
OLE and graphic objects are replaced by an empty rectangle.

Normal Mode - Quick View Plus attempts to match the original document's 
fonts with available Windows fonts.    The text appears with the advanced 
formatting preserved and wraps so that is does not run outside of the 
viewing area.

Preview Mode - All supported formatting is preserved.    In addition, lines 
are wrapped according to their wrap points in the printout instead of 
wrapping to fit the view window.

Options - Contains the following three submenu items:

Display...

Print...

Clipboard...



Spreadsheet Menu

The Spreadsheet Menu is only available when viewing spreadsheet files.    
This menu is also available as a right-click context menu.

Copy - Copies selected text, data or images to the Windows Clipboard.

Print - Prints the viewed file or selection.

Gridlines - Controls whether gridlines are displayed.    The default setting is 
on (checked).

Options - Contains the following three submenu items:

Display...

Print...

Clipboard...



Database Menu

The Database Menu is only available when viewing database files.    This 
menu is also available as a right-click context menu.

Copy - Copies selected text, data or images to the Windows Clipboard.

Print - Prints the viewed file or selection.

Gridlines - Controls whether gridlines are displayed.    The default setting is 
on (checked).

Options - Contains the following three submenu items:

Display...

Print...

Clipboard...



Bitmap Menu

This menu allows you to set various display options for bitmap files and is 
only available when viewing bitmap files.    This menu is also available as a 
right-click context menu.

Copy - Copies selected text, data or images to the Windows Clipboard.

Print - Prints the viewed file or selection.

Show Full Screen - When you select this option the bitmap fills the entire 
screen.    To return to Quick View Plus press any key or click a mouse button.   
(Please note that bitmaps viewed in full screen mode can be scrolled using 
the cursor movement keys.)

Size - The Size menu option allows you to scale the bitmap in several ways.   
Note that any options other than original size may cause the bitmap to look 
grainy or rough.

Original Size - This option views the bitmap with the same height and
width as it was originally created.    Use the scroll bars to scroll the 
image if the bitmap is larger than the window.

Fit to Window - This option scales the bitmap to be as large as 
possible while still fitting in the viewing window and maintaining the 
aspect ratio.

Fit to Window Width - This option scales the bitmap so that the 
bitmap width is equal to the width of the viewing window.

Fit to Window Height - This option scales the bitmap so that the 
bitmap height is equal to the height of the viewing window.

Rotation - This option allows bitmaps to be rotated at angles of 90, 180, 270
or zero degrees.    This is useful when viewing fax or scanned images which 
are stored landscape or upside down.

Zoom - The Zoom menu option offers several options for magnifying the 
display of bitmap files.    These options are:

In - Magnifies the entire graphic by a single order of magnitude.    This 
command may be repeated to increase magnification.

Out - Reduces the entire graphic by a single order of magnitude.    This 
command may be repeated to further reduce the display size.



Selection - Magnifies the current selection by a single order of 
magnitude.

Reset - Restores the bitmap to the original dimensions .

Dither - If you use a 16- or 256-color setup, you may occasionally view 
bitmaps created at a higher color resolution than is available on your system.
To achieve more accurate color rendering in these circumstances, Quick View
Plus offers a dithering option for bitmaps only.    When dithering is on, colors 
that are not available are represented by combinations of available colors 
that most closely recreate the original color.

To turn dithering on, view a bitmap.    Then open the Bitmap menu and select 
Dither.    This option will be grayed out if dithering would not benefit the 
image being viewed.    Dithering will remain on for bitmaps until it is turned 
off.

Options - Contains the following three submenu items:

Display...

Print...

Clipboard...



Drawing Menu

This menu allows you to set various display options for drawing (vector) files 
and is only available when viewing drawing files.    This menu is also available
as a right-click context menu.

Copy - Copies selected text, data or images to the Windows Clipboard.

Print - Prints the viewed file or selection.

Show Full Screen - When you select this option the drawing fills the entire 
screen.    To return to Quick View Plus press any key or click a mouse button.

Size - The Size menu option allows you to scale the drawing in several ways.

Original Size - This option views the drawing with the same height 
and width as it was originally created.    Use the scroll bars to scroll the 
image if the drawing is larger than the window.

Fit to Window - This option scales the drawing to be as large as 
possible while still fitting in the viewing window and maintaining the 
aspect ratio.

Fit to Window Width - This option scales the drawing so that the 
drawing width is equal to the width of the viewing window.

Fit to Window Height - This option scales the drawing so that the 
drawing height is equal to the height of the viewing window.

Stretch to Window - This option stretches the drawing so that the 
drawing width is equal to the viewing window width and the drawing 
height is equal to the viewing window height.    The aspect ratio is likely
to be changed.

Zoom - The Zoom menu option offers several options for magnifying the 
display of drawing files.    These options are:

In - Magnifies the entire graphic by a single order of magnitude.    This 
command may be repeated to increase magnification.

Out - Reduces the entire graphic by a single order of magnitude.    This 
command may be repeated to further reduce the display size.

Selection - Magnifies the current selection by a single order of 
magnitude.



Reset - Restores the bitmap to the original dimensions .

Options - Contains the following three submenu items:

Display...

Print...

Clipboard...



Archive Menu

The archive menu allows saving compressed file entries to disk in 
uncompressed form and is available only when viewing archive file formats 
(ZIP).    This menu is also available as a right-click context menu.

Copy - Copies selected text, data or images to the Windows Clipboard.

Print - Prints the viewed file or selection.

Extract Selected Files... - This option saves the selected file entries to disk
in uncompressed form.    When chosen, a dialog box appears prompting you 
to choose the directory where the uncompressed files should be created.    
This dialog box is only used to choose the directory, not the name of the 
output file(s).

Extract All Files... - This option saves all of the file entries to disk in 
uncompressed form.    This option also brings up a dialog box prompting for 
the directory to create the uncompressed files.

Options - Contains the following three submenu items:

Display...

Print...

Clipboard...



Menu Commands

Help Menu
Contents
Search for Help on...
How to Use Help
About Quick View Plus...



Help - Contents

The Help Contents command accesses the first screen of the Quick View Plus
help system.    The help contents can be accessed at any time using the 
menu or by pressing F1.

Context sensitive help on any menu command can be accessed by 
highlighting the menu command and then pressing F1.



Help - Search for Help on...

This command accesses the search facility built into the help system.    When
accessed, a list of keywords is provided.    You can also enter topics into the 
box provided, and Help will match your text with available keywords.    After 
selecting a keyword, all related help topics can be found.    Help on the 
chosen topic can then be displayed.



Help - How to Use Help

Use this option for a detailed description of the help system.



Help - About Quick View Plus...

This menu command brings up an information window which provides the 
Quick View Plus version number and system information.



Understanding the Quick View Plus Window

Window areas
Menu Bar
File Specification Window
Drive Window
Directory Window
Files Window
File Information Line
Tool Bar
View Window



Menu Bar

The menu bar provides quick access to many features of the product.    To 
select a menu item, single click on the item or use the Alt-key combined with
the underlined letter.    The following menus are available:

File Menu
Edit Menu
View Menu
Options Menu
Help Menu

One of the following menus is available when viewing a file of the 
corresponding file type:

Document Menu
Spreadsheet Menu
Database Menu
Bitmap Menu
Drawing Menu
Archive Menu



 Entering a File Specification

To limit the files that you see in the Files Window, you can set specifications 
in the File Specification Window.    Most often, the specification will include 
wildcards.

Wildcards allow you to use the * and ? characters.    The * represents any 
number of characters in that position.    The ? only represents one character 
in that position.    You can use these characters together, or separately.    

For example, suppose you only want to view files that end in the extension 
DOC.    In the File Specification Window, type *.DOC and press Enter.    Notice 
that the Files Window now only displays files that end in DOC.



      Selecting a Drive to Browse

The Drive Window shows the current drive.    To see a list of drives known to 
your system, choose the down arrow next to the Drive Window.    A drop 
down list appears.    You can select any of the drives listed.    Once selected, 
the drive's directories display in the Directory Window.



      Selecting a Directory to Browse

If the directory or subdirectory you want is not currently selected, you can 
view a different directory by choosing it in the Directory/Tree window.

Use the scroll bar or cursor keys to quickly browse the list.    Pressing an 
alphanumeric key while browsing the Directory/Tree Window will quickly 
highlight the next directory with a matching first character.

In Directory mode, select the parent directory symbol  to move up a 
directory:

To expand the Directories Window, choose the  button on top of the 
Directories Window.    Quick View Plus expands the window.    To return to the 
normal browse mode, choose the 

 button.



          Selecting a File to View

The Files Window displays a list of the files located in the selected directory 
on the selected drive which match the current file specification. or the Find 
criteria in effect in Find mode.

Choose one of the methods below to view a file in the list:
Highlight the filename and click on 

Double click on the filename.    Viewing on single click can also be set in
the General Options.

Highlight the filename and press Enter.

Highlight the filename and choose view from the file menu.

Highlight the filename and use the accelerator key (F4).

Use the scroll bar or cursor keys to quickly browse the list.    Pressing an 
alphanumeric key while browsing the Files Window will quickly highlight the 
next file with a matching first character.

To expand the Files Window, choose the  button on top of the Files Window.  
Quick View Plus expands the window.    To return to the normal browse mode, 
choose the 

 button.

See Also: Sort files by, Drag and Drop



 File Information Line

The file information line is a window which acts as a title to the currently 
viewed document.    This window includes the filename, file type, file size, 
and the date/time the file was last modified.

This window also provides a quick way to tear off a view of the file into a 
separate window.    When the mouse cursor is moved over the file information
line, holding down the left mouse button, dragging the cursor to the left or 
the right, and releasing the mouse button will tear off the current view 
window into a separate window.



Using the Toolbar

The toolbar is a set of buttons used to speed up some of the frequently used 
operations.    Click on any button below for help on the associated operation:

 
 
 
 
 
 
 
 
 
 
 
 
 



 View Window

The view window is the center of the Quick View Plus product.    This window 
displays a highly formatted view of the currently selected document.

All or part of a view can be selected.    The selected section can be copied to 
the clipboard and then pasted into any windows application.

Quick View Plus can also print all or part of a view.



 How To...

Change Drives
Browse Directories
Select a File to View
Use the File Finder
Select Part or All of a View
Copy Data from Quick View Plus to your Windows Application
Launch a View
Print All or Part of a View
Search Within a View
Tear Off a View



 Keyboard Help

F1 Help
F2 (Un)Zoom
F3 Open
F4 View
F5 Close
F6 Print
F7 Launch
F8 Tear Off
F9 File Rename
F10 File Copy
F11 File Move
F12 File Delete
Ctrl-A Select All
Ctrl-C Copy
Ctrl-S Search
Ctrl-P Search Previous
Ctrl-N Search Next



 Troubleshooting Quick View Plus Windows

In using Quick View Plus you may encounter situations that require further 
clarification, both with respect to the program's behavior and that of the 
applications with which you are using Quick View Plus.    This section offers 
information and advice to help you better understand these situations. 

Finding Your File
Importing Data
Viewing Files
Launching Files
Printing Files
Error Messages



 Trouble Finding Your File

The File List window shows no files, though I know files are there.
You have probably set a file specification for viewing a previous directory that
no longer applies in the new directory you are viewing.    If, for example, you 
were using the file specification *.sam to view all your Ami Pro files, and 
then changed to a directory containing no Ami Pro files, no files would be 
displayed.    To correct the problem, change your file specification to *.*.

In Find mode, no files appear in the File List window.
You must first execute a file search.    Find mode only lists files that have 
been found as the result of a search.

I did a file search, but I could not find my file in the returned list, 
though the file does appear in the Windows File Manager.
The file list returned from a File Find search is not alphabetized.    The files are
listed in the order in which they are found.    It may seem your file is not there
because it is not listed in the order in which you expect it to appear.



 Trouble Importing Data

I have copied data to the Clipboard, but the Paste function is grayed
out in my word processor's menu.
Many applications will have the Paste options grayed out if the data on the 
clipboard is not in a format that it can import.    Check your Clipboard Options
to verify you have selected a clipboard format your word processor can 
support.    Below is a quick checklist:

Into Word Processor Clipboard Format
Microsoft Word for Windows RTF
WordPerfect for Windows RTF
Ami Pro Ami Pro 2 & 3
Ami Pro 1.2 Ami Pro 1.2
JustWrite RTF
Legacy Legacy
WordStar for Windows WordStar for Windows
Professional Write + Professional Write +

Moreover, WordStar for Windows and Legacy both require that the Clipboard 
contents be available in both Text and their proprietary formats.    So if you 
are importing into WordStar for Windows or Legacy, be sure that Text is 
chosen as well as WordStar for Windows or Legacy in your options.

I pasted a series of paragraphs, but the last paragraph lost its 
formatting.
The paragraph formatting is contained in the paragraph mark.    You probably
did not select the entirety of the last line of that paragraph, and so did not 
copy its paragraph mark.    Try reselecting and reimporting.

When pasting data into WordStar for Windows, none of the 
paragraph formatting or tabstops are retained.
This occurs because WordStar for Windows requires a change to style sheet 
properties to alter paragraph and tabstop formatting.    Ami Pro 1.2 and 
Professional Write Plus have a similar limitation with respect to paragraph 
formatting, though not with tabstop formatting. 

When pasting text into Ami Pro, I sometimes get the error message 
"Cannot place text".    
This is an Ami Pro message that occurs when you attempt to paste text that 
has left and right indents that, given the target document's page margins, 
would overlap.    To paste the text without this error message occurring, you 
can (a) uncheck paragraph indent support in the Document Options group or 
(b) widen the page margins of your Ami Pro document.



After pasting into my application, the data does not wrap or align 
properly, though paragraph indents were supported correctly.
Several factors can contribute to this situation:

Quick View Plus does not support margin changes, only indents.

The page margins of your target document may be smaller or larger than 
those of your source document or file.    You may have to adjust the page 
margins of the target file to match those of the original file.

All my text pastes in with an incorrect font size.
You may have inadvertently unchecked the character size box in your 
Document Options.    When this box is not checked, Quick View Plus uses the 
default font size you have specified in the Clipboard Output Font group in the
same dialog box.    To see if this is the case, choose Clipboard... from the 
Quick View Plus Options Menu while viewing a document.    If Character Size 
is unchecked in the Include On Clipboard group, then Quick View Plus will use
the value in the Size selection box when copying to the clipboard.    Change 
this size and then recopy and re-paste your text.

Additionally, Quick View Plus will use the default font size specified in the 
Clipboard Output Font group for text that, in the original document, contains 
no information specifying the font size.    Again, change the font size in this 
group to the desired font.

I imported data as a table, but the entire table does not display 
after paste, only part of it.
The table is too wide for the target page.    Unlike text or tab-aligned data, 
tables cannot be wrapped to fit the target document margins.    Each word 
processor determines how to paste a table that is too wide for the margins, 
but most will display part, but not all of the table.    To correct this problem, 
either select a narrower group of data, or widen the margins of the target 
document.



 Trouble Viewing Files

When I try to use Quick View Plus's viewers under Norton Desktop 
for Windows, I get Norton's own viewers.

There are two possible reasons for this problem:

(a) You have not set the Quick View Plus viewers as the Norton Desktop 
default viewers.    To do this, choose the Norton Desktop Viewer icon to 
enter the viewer facility.    Select the Viewer menu and choose the item 
Set Default Viewer.    In the list box for this item, choose Quick View 
Plus Viewers.    Choose OK to save and exit.

(b) Quick View Plus was not integrated with Norton Desktop for Windows.    
This integration occurs automatically during installation if Norton 
Desktop is already on your system.    If, however, you installed Quick 
View Plus and then installed Norton Desktop for Windows, Quick View 
Plus will not be integrated.    If this is the case, re-install Quick View 
Plus.

Documents and data files display incorrectly--formatting codes and 
strings of numbers appear in place of the expected text or data.
You may be in ASCII or Hex view mode.    If so, select Normal from the View 
menu and re-view the file.

I do not see some of my fonts listed in the Clipboard Output Font list
box in the Document Options dialog box.
These are probably print fonts.    Quick View Plus will only use screen fonts 
defined for your system.    In many cases, these will be the same as your 
print fonts, though differences may occur depending on your Windows set 
up.



 Trouble Launching Files

The application which created the file is successfully run, but does 
not load the file from Quick View Plus.
Either the application has not been correctly set up in the Launch Application
Setup Options or is one of the following applications which cannot load a file 
from the command line:

DataEase 4.2
dBase III
dBase IV
DisplayWrite 2 - 5
Enable
First Choice 2.0 - 3.02
Lotus 1-2-3 (DOS versions)
Lotus Manuscript
Lotus Symphony
Mass-11
Microsoft Excel 2.10
Mosaic Twin
MultiMate 3.6 & 4
MultiMate Advantage II
Paradox
Paradox 3.0
PC File 5.0
Q&A
R:Base 3.1
Samna IV
Smartware II
Volkswriter 3
VP Planner 3D

Check the Launch Options Settings to verify that there is no extraneous 
information on the path.    For more information see Launch.

When I try to launch the application, a DOS session is created but 
quickly terminated and I return to Quick View Plus.
The path to the application is incorrect or DOS cannot find the application 
specified.    Ensure that the path is correct by using the Search or Browse 
options in the Launch Application Setup Dialog Box.

When I am in the Launched Application I cannot switch back to 
Windows.
Ensure that you have sufficient disk space to perform the context switching.   

I cannot use certain Alt key combinations in my DOS application.
Some applications require the use of the keys used to switch between 



applications.    You can create a PIF file which reserves these keys for 
Windows.    Consult your Windows manual for information on creating PIF 
files.

The launched application will not run in a Window.
Windows must be running in 386 Enhanced mode.    To check the state of 
Windows operation, use the About Program Manager Dialog Box from the 
Help menu of the Program Manager.

The Search feature fails to find my application.
The Search feature does not search network drives.    Use the Browse feature 
to locate applications on these drives.



 Trouble Printing Files

I chose the Print option but only a blank page printed.
The Print dialog box gives you the option of printing the whole file or only a 
selection.    If no text is selected and the options are set to    "Print Selection" 
a blank page will be produced.    To print the whole file, select "Print Whole 
Document" from the Print dialog box.



 Quick View Plus Error Messages

View window has run out of memory
The view window could not allocate a block of memory. This means system 
memory, not system resources or hard disk.

View window has encountered a corrupt file

The filter encountered an inconsistency in the file while reading it.

View window could not open the file

The file does not exist
or
The file is opened by another process in DENY READ or DENY ALL sharing 
mode
or
The file name is invalid

View window could not access the DLLs it needed to view the file

The filter DLL (VS3*.DLL) was not found

View window has encountered a bad file

The filter encountered an inconsistency in the file while opening it.

View window has encountered a password protected or encrypted 
file

Quick View Plus does not view password coded files.    To view the file, 
remove the password and re-view.

View window could not open extra files needed to view

Certain formats (RBase & DataEase) store a single "database" in more than 
one file. All of these files must be in the same directory for Quick View Plus to
view the database.    This error means that one of these extra files could not 
be found.

This file contains no data

File is empty (contains no text, no cells or no records)

This section contains no data



Same as above, but for multi-section document

A viewer for this file type is not available

The view window has identified the file as something other than UNKNOWN, 
but no filter is available.

View window can not write to the Windows temporary directory 
(disk full?)

Almost always means that the disk where the Windows temporary directory 
resides is full.



 File Finder

The Find mode allows you to search for, rather than browse for your file(s).    
The Quick View Plus window changes slightly when you are in this mode.

In Find mode, the File Spec, Drive, and Directory windows disappear.    In their
place appears a Setup button, a Find button, and Current Setup pull down 
list box.    The File window still appears, but it only shows those files that 
meet the requirements of the find.    The File window will show the results of 
the last find if the find was carried out in the current Quick View Plus session.

To change or set up a new Find criteria, choose the Setup button.    This 
button will bring up the File Finder Setup dialog box.

To execute the Find, choose the Find button.    During the operation, the 
drawers of the file cabinet go in and out as Quick View Plus searches the 
drive.    You will also notice that the Find button changes to the Stop button. 
Press this button at any time to stop the search.

As Quick View Plus finds files that fit the search parameters, it displays them 
in the File window.    You can view any of these files without canceling the 
remainder of the search.

The search is complete once the drawers stop opening.    Once the search is 
complete, all the directories and files that fit the search parameters appear 
in the Files window.

You can browse through and view files in the File window just as you would in
Tree or Directory mode.    



 File Find Setup Dialog

The File Find Setup dialog is accessed by pressing the Setup button while in 
find mode.

There are four major areas to the Setup File Find dialog box:    The Setup 
Name group, the Find these files... group, the Find files in... group, and 
the buttons related to Properties.

The Setup Name group allows you to select, create, or remove, file find 
configurations.    Each setup is uniquely described by the setup name.    This 
design allows you to easily create file find criteria for files which you often 
need to locate.

To select an existing setup, use the pull down menu and choose the 
setup desired.

To create a new setup, press the New... button.    A dialog box will 
appear prompting you for a descriptive name of the setup which you 
are about to create.    After entering a name and pressing OK, you will 
be returned to the Setup dialog box, and can modify the find properties
to locate your files.

To remove an existing setup from the setup list, first select the setup 
you wish to remove, then press the Remove... button.

The Find these files... group allows you to define the file specification and 
text search string used in locating files.

Files Named - Allows you to enter any valid DOS specification 
(including wildcard statements).

Containing the text... - Allows you to have Quick View Plus search 
for a particular text string.    When you enter a text string, Quick View 
Plus searches for the string in all files that meet the other search 
parameters.

Case sensitive - Determines if case sensitivity is off or on.    When 
case sensitivity is on, Quick View Plus searches for a string that has not
only the same characters as the search string, but also has the same 
capitalization patterns.

The Find files in... group contains the parameters that determine drives 
and directories to search.    Use the Drives & Directories list boxes to define
the search location.    The group consists of a set of radio buttons.    Select 
one of the buttons to determine where to search:



Selected path - Searches only in the directory selected in the drives 
and directories list windows.

Selected path & subdirectories - Searches the selected directory 
and any subdirectories under the selected directory.

Selected drive(s) - Searches on all drives highlighted in the Drives 
box.    This is a multiple selection list box.    You can choose as many 
drives as you want.    To unselect a drive, choose it again and the 
highlight disappears.

Local hard drives - Searches all local hard drives known to your 
system.

Network drives - Searches all network drives known to your system.

Local and network drives - Searches both local and network drives.

The Reset Properties button returns all search criteria to preset values.    
This is useful when redefining the search criteria.

The More Properties button brings up a dialog box which contains 
additional search criteria.    These parameters are described below:

Character Set - This set of radio buttons allows you to choose the character
set that is used when matching the text string entered in the Containing 
the text field.    When searching DOS, Windows, and Macintosh files, this 
parameter is useful primarily as a way to find the correct extended 
characters (which are different in all three environments).    You must use this
parameter when searching for a string in EBCDIC files, whether the string 
includes extended characters or not.    EBCDIC file formats include RFT, FFT, 
and DisplayWrite files.

File Dates - This group allows you to set the minimum and/or maximum 
dates of files to include in the search.    If you set both an Earliest and Latest 
date, the search will only return files which were last modified on or between 
the selected dates.

Earliest - Allows you to find only those files created on or after a 
certain date.    You can set the Month, Day, and Year of the earliest date
by typing them in, or by scrolling with the up and down arrows that 
appear by each field.

Latest -Allows you to find those files created on or before a certain 
date.    You can set the Month, Day, and Year of the latest date by 



typing them in, or by scrolling with the up and down arrows that 
appear by each field.

File Sizes - This group allows you to set minimum and/or maximum file 
sizes.    You can set file sizes in increments of Bytes, Kilobytes, or 
Megabytes.

File Attributes - This group allows you to define the state of the archive file 
attribute of the files to find.    Use the radio buttons to either Ignore the 
Archive flag, include Files with Archive flag, or include Files without 
Archive flag.

Type of file - Determines the format of the file you want to find.    Choosing 
the All types radio button searches all formats.    Choosing Selected types 
searches the files that have their formats highlighted in the File Type list box. 
This dialog box is a multiple selection box.    You can choose as many types 
as you want.    To deselect a file type, choose it again and the highlight 
disappears.

Once you have set up the find options, select OK.    Upon returning to the 
main window, press the Find button to execute the find.



 Drag and Drop

Quick View Plus supports viewing files which are dragged from the Windows 
File Manager and dropped onto Quick View Plus.    To view a file using Drag 
and Drop, do the following:

1. Use the File Manager to list files in any directory or drive.
2. Select the file you wish to view.
3. Locate the cursor over the filename and hold down the left mouse 

button.
4. Drag the file by moving the mouse with the button held down.
5. Place the file over the Quick View Plus window or icon.
6. Release the mouse button to drop the file.
7. Quick View Plus will view the file.

Quick View Plus must already be running for drag and drop to take effect.



 Word Processor Macros

Quick View Plus supplies macros for Ami Pro, Word for Windows, and 
WordPerfect for Windows.    These macros allow you to access Quick View 
Plus using one simple step.    

When you install an Quick View Plus macro, the macro name is automatically
added to the word processor menu.    When you select this menu option, the 
macro keeps the word processor window open, and loads Quick View Plus.    
The menu under which you find the macro varies between word processors:

Word Processor Menu
Ami Pro Tools Menu
Word for Windows 1.x Utilities Menu
Word for Windows 2.x and 6.x Tools Menu
WordPerfect for Windows 5.x Macro Menu
WordPerfect for Windows 6.x Tools Menu

If you use the macros, then the Paste to application option of the Edit menu 
is enabled.    Whenever you choose this option, Quick View Plus pastes the 
selected data directly to your word processor and returns to your word 
processor.    

When invoked through macros, you can also paste selected text by choosing 
the button that appears in the tool bar.



 Integrating Quick View Plus

During Installation you have the option of integrating Quick View Plus with a 
variety of other programs.    Once integrated, Quick View Plus's viewers 
become available directly from within the integrated program.    Programs 
supporting integration are listed below:

File Managers
Windows 3.1 File Manager
Windows for Workgroups File Manager
Norton Desktop for Windows
WordPerfect Office for Windows

E-Mail Programs
Microsoft Mail for Windows
Lotus cc:Mail for Windows
DaVinci eMail for Windows
WordPerfect Mail (in WordPerfect Office)

When invoked from within one of the above programs, Quick View Plus will 
use a slightly different interface than the stand-alone Quick View Plus 
program.    This new interface is called the AddOn Window.

The AddOn Window provides a tool bar featuring Launch, Print, Copy, Search,
Search Next, and Search Previous.    Also, the display, print, and clipboard 
options for each file type are available from the drop-down menu to the right 
of the tool bar.    The name of this menu will change depending on the file 
type viewed.

Quick View Plus provides an AddOn Manager module that keeps track of the 
integrated applications and allows the user to enable or disable integration 
with a particular application.    The AddOn Manager is copied to the Startup 
group under Windows 3.1 during installation.    If the startup group is not 
present under Windows 3.1, or if the user is installing under Windows 3.0, the
AddOn Manager's path and filename will be added to the Load line of the 
user's WIN.INI.

The result of either method is that the AddOn manager will be loaded in 
memory every time Windows is run.    This is necessary for the Quick View 
Plus AddOn interface to be invoked from within cc:Mail, WordPerfect Office, 
and DaVinci eMail.

To access the AddOn Manager, simply click on its icon in the Startup group.    
The AddOn Manager will list the integrated applications.    An information 
window describes the selected application.    Two buttons, Enable & Disable, 
allow the user to enable or disable the selected integration.





 Windows 3.1 File Manager Integration

Quick View Plus allows you to integrate with the Windows file manager (if 
you have Windows 3.1 or higher).    This occurs automatically during 
installation.    Once integrated, the File Manager menu includes an QVP 
option.    Choose this option to load the Quick View Plus AddOn Window.

The integration feature is useful when you want to browse files in the 
Windows File Manager, and then use Quick View Plus to view them.    Once 
you find the file you want, you can select the QVP option from the menu.    
This will run the Quick View Plus AddOn and view the selected file.    You can 
also use Drag and Drop to view a file.



 Windows for Workgroups File Manager Integration

Quick View Plus allows you to integrate with the Windows for Workgroups file 
manager.    This occurs automatically during installation.    Once integrated, 
Quick View Plus will display as a button on the File Manager.    Choose this 
button to load the Quick View Plus AddOn window.    You can also use Drag 
and Drop to view a file.



 Norton Desktop Integration

When Quick View Plus is integrated with Norton Desktop for Windows, Quick 
View Plus's AddOn window is available in a variety of contexts.    It is 
imperative, however, that the user first set up the Quick View Plus Viewers 
as the Norton Desktop for Windows default file viewers.    If this is not done, 
Norton will use its own viewers instead of Quick View Plus's.

To make Quick View Plus serve as the default viewers:

1. Select the Norton Viewer icon to enter its viewer facility.

2. From the Viewer menu, choose Set Default Viewer.

3. From the viewer list box, select Quick View Plus Viewers.    Select OK to 
save your choice.

Once made the default viewers, Quick View Plus's viewers may be invoked in
three contexts:

In Norton's Viewer facility - Simply open the Viewer facility by choosing 
the Viewer icon.    Then use File Open to select a file for viewing.

In Norton's File Manager - You access this function by selecting a Norton 
drive icon.    To view a file, single click on the file name and then choose the 
View button.    The file will be viewed in a new window below the drive and 
directory windows.    To view another file, single click on its name in the file 
list window.

By selecting the QVP menu option - This option is available from the 
Norton Desktop main menu.    Open this menu and choose View to start Quick
View Plus.

NOTE:    In order to use the QVP menu, you must already be viewing a file in 
the Norton File Manager.    Otherwise the View option under the QVP menu 
will be grayed out.

Of course, you can still run Quick View Plus as a standalone application under
Norton Desktop as you would run any other Windows application.



 Microsoft Mail Integration

If Microsoft Mail version is installed on your system, you can use Quick View
Plus to view files attached to your mail messages.

To view an attachment, simply double click on its icon within the Microsoft 
Mail message.    The Quick View Plus AddOn window will open, displaying the 
attached file.    Quick View Plus does not need to be running to view Microsoft
Mail attachments.

Occasionally you may want to revert to Microsoft Mail's default behavior with
respect to attachments.    In default mode, double-clicking on a mail 
attachment causes Microsoft Mail to attempt to launch the attached file, 
using the associations established in the Windows Registration Database.    
This behavior is overridden if Quick View Plus has been integrated.    
However, holding down the CTRL key while double clicking on an attachment
will restore the default response, i.e., instead of being viewed in the 
Attachment Handler, the attachment will be launched using Microsoft Mail's 
capabilities.



 WordPerfect Office Integration

Integration into WordPerfect Office provides viewing for both Mail 
attachments and from the WordPerfect File Manager.    In WordPerfect Mail, 
Quick View Plus's AddOn interface is used to view the mail message itself 
and attachments.    From within WordPerfect Mail, click on the mail message 
or attachment you wish to view.    The AddOn window appears integrated 
within WordPerfect Office.



 DaVinci eMail Integration

Integration into DaVinci eMail provides view of attachments directly from 
DaVinci eMail.    To view an attachment in DaVinci:

Load DaVinci eMail and view the desired mail message as you normally
would.

Choose the Attachments button or choose Attachment from the 
Message menu.    A dialog box listing any attachments will appear.

Select the attachment you wish to view and then click on the View 
button.    You can also choose multiple attachments simultaneously in 
this list.

The Quick View Plus AddOn window appears with the selected 
attachment viewed.    If you selected multiple messages, multiple 
AddOn windows will appear.



 Lotus cc:Mail Integration

Integration into cc:Mail provides viewing of attachments directly from 
cc:Mail.    To view an attachment from within cc:Mail:

Load cc:Mail and view the desired mail message as you normally 
would.

If you are using the default cc:Mail settings, Shift-double-click on the 
attachment you wish to view.    If you have changed the default, double
click on the attachment.

The AddOn window appears.    This window is integrated with the 
cc:Mail window.



 Selection Methods

Selecting within a Document View

Text Selection
To manually select text in a word processor view, tab into the view window 
and use Shift-cursor to select text.

To select text with a mouse, move the mouse pointer to the beginning of the 
section you want.    Next, hold down the left mouse button and drag the 
pointer to the end of the section.    As you move the mouse, all of the text 
between the beginning and end of the selection is highlighted.    Once you 
highlight the text you want, you can release the mouse button and the 
section will remain highlighted.    You can also select the entire view with the 
Select All command.

Selecting within a Spreadsheet or Database View

Block Selection
To select a block in a spreadsheet or database view, move the mouse pointer
to the top left corner of the block to be selected.    Next, hold down the left 
mouse button and drag the pointer to the bottom right corner of the block to 
select.    As you move all of the data within the block defined by the 
beginning and the end of the selection is highlighted.    When the entire block
is highlighted, release the mouse button and the block remains selected.    
You can also select the entire view with Select All command.

Row Selection
To select a range of rows in a spreadsheet or records in a database view, 
move the mouse pointer over the row number of the top row of the range to 
be selected.    Hold down the left mouse button and drag the pointer to the 
bottom row of the range.    As the mouse moves over the rows they become 
selected.    When all of the rows in the range are selected, release the mouse 
button and the range remains highlighted.

To select multiple sets of rows, hold the control key while selecting as 
described above.    This will add the new rows to the selected area without 
canceling previously selected rows.

Column Selection
To select a range of columns in a spreadsheet or fields in a database view, 
move the mouse pointer over the column heading of the leftmost column of 
range to be selected.    Hold down the left mouse button and drag the pointer
to the rightmost column of the range being selected.    As the mouse moves 



over the columns they become highlighted.    When all of the columns in the 
needed range are selected, release the mouse button and the range remains
highlighted.

To select multiple sets of columns, hold the control key while selecting as 
described above.    This will add the new columns to the selected area 
without canceling previously selected columns.

Cross Selection
Cross selection is a feature which allows multiple sets of rows and columns to
be selected such that only the intersection of all selected rows and columns 
become part of the highlighted selection.    To cross select, select rows and 
columns as described above while holding down the control key.    Only the 
spreadsheet cells or database fields which fall within the selected rows and 
columns will be highlighted.    Once a row or column is selected, it can be 
deselected by repeating the selection procedure on that row or column.    The
selected area can then be copied or printed just like any other selection.

Selecting within an Bitmap or Drawing View

To select a part of a Bitmap or Drawing view, place the mouse pointer at a 
corner of the area you wish to select, hold down the left mouse button, drag 
the mouse to the opposite corner of the area to select, and release the 
mouse button.    A rectangle is displayed identifying the selected area.    This 
area can be printed or copied to the clipboard.    You can also zoom in on the 
selected area by clicking the right mouse button while the mouse pointer is 
located within the selected area.



 Transferring Data to your Windows Application

To transfer data from a file into your Windows application, do the following:

1. Select a File to View
2. Select the text or data to transfer
3. Copy the selection to the Clipboard
4. Return to your application
5. Select the Edit Paste command in your application to paste the 

Clipboard contents at the insertion point.

Note:    When using the word processor macros steps 3, 4, and 5 are 
combined into a single step.



Hide/Show Toolbar command (View menu)

To turn off the Tool Bar, on the View menu choose the Hide ToolBar option.    Quick View
Plus will remove the Tool Bar.    To show the Tool Bar, on the View menu, choose Show 
ToolBar.



      Directory Mode command (View menu)

This command selects the directory mode as the mode to browse directories and files.    
Quick View Plus also provides tree mode and find mode.

In Directory mode, the Directory window only shows those subdirectories under the 
current directory.    The parent directory appears with an up arrow on it.    If you double 
click on a subdirectory, it becomes the new parent directory.    Select the parent directory

symbol  to move up a directory:

To expand the Directories Window, choose the  button on top of the Directories 
Window.    Quick View Plus expands the window.    To return to the normal browse mode,
choose the 

 button.

See Also:    Selecting a Directory to Browse



      Tree Mode command (View menu)

This command selects the tree mode as the mode to browse directories and files.    
Quick View Plus also provides directory mode and find mode.

In Tree mode, the Tree window shows the structure of every directory and subdirectory 
on the current drive.    This is useful when you want to see the drive's entire directory 
structure at a glance.

To expand the TreeWindow, choose the  button on top of the Tree Window.    Quick 
View Plus expands the window.    To return to the normal browse mode, choose the 

 button.

See Also:    Selecting a Directory to Browse



      Find Mode command (View menu)

This command selects the find mode as the mode to browse files.    Quick View Plus 
also provides directory mode and tree mode.

This mode provides a powerful File Finder which can be used to locate files by filename,
file type, location, text search, and many other criteria.

For a complete description see File Finder.



Zoom/Unzoom command (View menu- F2)

This command toggles the zoom mode of the document viewing window.    In Zoom 
mode, you expand the Document Viewing Window so you can see more of the file you 
are viewing.    From the View menu, choose Zoom View. 

Once a view is zoomed, use this command to Unzoom the view.



Normal View command (View menu)

When a file is first selected for viewing, it comes up in the normal view mode.    This 
mode provides a highly formatted view of the document.    Any file can also be viewed 
using the ASCII View or the Hex View. Use this command to switch back to normal view
from one of the other view modes.



ASCII View command (View menu)

Any file can be viewed as a flat ASCII file.    This view mode will remove all formatting 
from the view and display all data in the file as if it were an ASCII file.    Any file can also 
be viewed using the Normal View or the Hex View.    This option is only available after 
initially viewing a file in Normal mode.



HEX View command (View menu)

Use this command to view the binary data within a file as series of hexadecimal bytes.    
This view mode is useful for technical purposes of getting a raw view of a file.    This 
option is only available after initially viewing a file in Normal mode.

See Also: Normal View, ASCII View.



Previous File command (View menu - KeyPad -)

This command highlights and views the previous file in the file list.    The short-cut key 
for this feature is KeyPad-Minus.    This is very useful for quickly browsing the file list, 
viewing as you go.



Next File command (View menu - KeyPad +)

This command highlights and views the next file in the file list.    The short-cut key for 
this feature is KeyPad-Plus.    This is very useful for quickly browsing the file list, viewing
as you go.


